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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.

Details

Product Status Active

Number of LABs/CLBs 8375

Number of Logic Elements/Cells 67000

Total RAM Bits 4526080

Number of I/O 295

Number of Gates -

Voltage - Supply 1.14V ~ 1.26V

Mounting Type Surface Mount

Operating Temperature -40°C ~ 100°C (TJ)

Package / Case 484-BBGA

Supplier Device Package 484-FPBGA (23x23)

Purchase URL https://www.e-xfl.com/product-detail/lattice-semiconductor/lfe3-70ea-8lfn484i

Email: info@E-XFL.COM Address: Room A, 16/F, Full Win Commercial Centre, 573 Nathan Road, Mongkok, Hong Kong
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Figure 2-2. PFU Diagram

Slice 
Slice 0 through Slice 2 contain two LUT4s feeding two registers, whereas Slice 3 contains two LUT4s only. For 
PFUs, Slice 0 through Slice 2 can be configured as distributed memory, a capability not available in the PFF. 
Table 2-1 shows the capability of the slices in both PFF and PFU blocks along with the operation modes they 
enable. In addition, each PFU contains logic that allows the LUTs to be combined to perform functions such as 
LUT5, LUT6, LUT7 and LUT8. There is control logic to perform set/reset functions (programmable as synchronous/
asynchronous), clock select, chip-select and wider RAM/ROM functions. 

Table 2-1. Resources and Modes Available per Slice

Figure 2-3 shows an overview of the internal logic of the slice. The registers in the slice can be configured for posi-
tive/negative and edge triggered or level sensitive clocks.

Slices 0, 1 and 2 have 14 input signals: 13 signals from routing and one from the carry-chain (from the adjacent 
slice or PFU). There are seven outputs: six to routing and one to carry-chain (to the adjacent PFU). Slice 3 has 10 
input signals from routing and four signals to routing. Table 2-2 lists the signals associated with Slice 0 to Slice 2.

Slice

PFU BLock PFF Block

Resources Modes Resources Modes

Slice 0 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 1 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 2 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 3 2 LUT4s Logic, ROM 2 LUT4s Logic, ROM

Slice 0

LUT4 &
CARRY

LUT4 &
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D D

Slice 1

LUT4 &
CARRY

LUT4 &
CARRY

Slice 2

LUT4 &
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From
 Routing
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 Routing

Slice 3

LUT4 LUT4

D D D D

FF FF FF FF FF FF
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Modes of Operation
Each slice has up to four potential modes of operation: Logic, Ripple, RAM and ROM. 

Logic Mode
In this mode, the LUTs in each slice are configured as 4-input combinatorial lookup tables. A LUT4 can have 16 
possible input combinations. Any four input logic functions can be generated by programming this lookup table. 
Since there are two LUT4s per slice, a LUT5 can be constructed within one slice. Larger look-up tables such as 
LUT6, LUT7 and LUT8 can be constructed by concatenating other slices. Note LUT8 requires more than four 
slices.

Ripple Mode
Ripple mode supports the efficient implementation of small arithmetic functions. In ripple mode, the following func-
tions can be implemented by each slice: 

• Addition 2-bit 

• Subtraction 2-bit 

• Add/Subtract 2-bit using dynamic control 

• Up counter 2-bit 

• Down counter 2-bit

• Up/Down counter with asynchronous clear

• Up/Down counter with preload (sync) 

• Ripple mode multiplier building block

• Multiplier support 

• Comparator functions of A and B inputs
—  A greater-than-or-equal-to B
—  A not-equal-to B
—  A less-than-or-equal-to B

Ripple Mode includes an optional configuration that performs arithmetic using fast carry chain methods. In this con-
figuration (also referred to as CCU2 mode) two additional signals, Carry Generate and Carry Propagate, are gener-
ated on a per slice basis to allow fast arithmetic functions to be constructed by concatenating Slices.

RAM Mode
In this mode, a 16x4-bit distributed single port RAM (SPR) can be constructed using each LUT block in Slice 0 and 
Slice 1 as a 16x1-bit memory. Slice 2 is used to provide memory address and control signals. A 16x2-bit pseudo 
dual port RAM (PDPR) memory is created by using one Slice as the read-write port and the other companion slice 
as the read-only port.

LatticeECP3 devices support distributed memory initialization.

The Lattice design tools support the creation of a variety of different size memories. Where appropriate, the soft-
ware will construct these using distributed memory primitives that represent the capabilities of the PFU. Table 2-3 
shows the number of slices required to implement different distributed RAM primitives. For more information about 
using RAM in LatticeECP3 devices, please see TN1179, LatticeECP3 Memory Usage Guide.

Table 2-3. Number of Slices Required to Implement Distributed RAM 

SPR 16X4 PDPR 16X4

Number of slices 3 3

Note: SPR = Single Port RAM, PDPR = Pseudo Dual Port RAM

www.latticesemi.com/dynamic/view_document.cfm?document_id=32319
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Single, Dual and Pseudo-Dual Port Modes 
In all the sysMEM RAM modes the input data and address for the ports are registered at the input of the memory 
array. The output data of the memory is optionally registered at the output. 

EBR memory supports the following forms of write behavior for single port or dual port operation: 

1. Normal – Data on the output appears only during a read cycle. During a write cycle, the data (at the current 
address) does not appear on the output. This mode is supported for all data widths. 

2. Write Through – A copy of the input data appears at the output of the same port during a write cycle. This 
mode is supported for all data widths. 

3. Read-Before-Write (EA devices only) – When new data is written, the old content of the address appears at 
the output. This mode is supported for x9, x18, and x36 data widths.

Memory Core Reset 
The memory array in the EBR utilizes latches at the A and B output ports. These latches can be reset asynchro-
nously or synchronously. RSTA and RSTB are local signals, which reset the output latches associated with Port A 
and Port B, respectively. The Global Reset (GSRN) signal can reset both ports. The output data latches and asso-
ciated resets for both ports are as shown in Figure 2-22. 

Figure 2-22. Memory Core Reset

For further information on the sysMEM EBR block, please see the list of technical documentation at the end of this 
data sheet. 

sysDSP™ Slice
The LatticeECP3 family provides an enhanced sysDSP architecture, making it ideally suited for low-cost, high-per-
formance Digital Signal Processing (DSP) applications. Typical functions used in these applications are Finite 
Impulse Response (FIR) filters, Fast Fourier Transforms (FFT) functions, Correlators, Reed-Solomon/Turbo/Convo-
lution encoders and decoders. These complex signal processing functions use similar building blocks such as mul-
tiply-adders and multiply-accumulators. 

sysDSP Slice Approach Compared to General DSP
Conventional general-purpose DSP chips typically contain one to four (Multiply and Accumulate) MAC units with 
fixed data-width multipliers; this leads to limited parallelism and limited throughput. Their throughput is increased by 
higher clock speeds. The LatticeECP3, on the other hand, has many DSP slices that support different data widths. 
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Figure 2-31. MULTADDSUBSUM Slice 1

Advanced sysDSP Slice Features
Cascading
The LatticeECP3 sysDSP slice has been enhanced to allow cascading. Adder trees are implemented fully in sys-
DSP slices, improving the performance. Cascading of slices uses the signals CIN, COUT and C Mux of the slice.

Addition
The LatticeECP3 sysDSP slice allows for the bypassing of multipliers and cascading of adder logic. High perfor-
mance adder functions are implemented without the use of LUTs. The maximum width adders that can be imple-
mented are 54-bit.

Rounding
The rounding operation is implemented in the ALU and is done by adding a constant followed by a truncation oper-
ation. The rounding methods supported are:

• Rounding to zero (RTZ)

• Rounding to infinity (RTI)

• Dynamic rounding

• Random rounding

• Convergent rounding 
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Figure 2-38. LatticeECP3 Banks

LatticeECP3 devices contain two types of sysI/O buffer pairs. 

1. Top (Bank 0 and Bank 1) and Bottom sysIO Buffer Pairs (Single-Ended Outputs Only)
The sysI/O buffer pairs in the top banks of the device consist of two single-ended output drivers and two sets of 
single-ended input buffers (both ratioed and referenced). One of the referenced input buffers can also be con-
figured as a differential input. Only the top edge buffers have a programmable PCI clamp.

The two pads in the pair are described as “true” and “comp”, where the true pad is associated with the positive 
side of the differential input buffer and the comp (complementary) pad is associated with the negative side of 
the differential input buffer. 

The top and bottom sides are ideal for general purpose I/O, PCI, and inputs for LVDS (LVDS outputs are only 
allowed on the left and right sides). The top side can be used for the DDR3 ADDR/CMD signals. 

The I/O pins located on the top and bottom sides of the device (labeled PTxxA/B or PBxxA/B) are fully hot 
socketable. Note that the pads in Banks 3, 6 and 8 are wrapped around the corner of the device. In these 
banks, only the pads located on the top or bottom of the device are hot socketable. The top and bottom side 
pads can be identified by the Lattice Diamond tool.
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2. Left and Right (Banks 2, 3, 6 and 7) sysI/O Buffer Pairs (50% Differential and 100% Single-Ended Out-
puts)
The sysI/O buffer pairs in the left and right banks of the device consist of two single-ended output drivers, two 
sets of single-ended input buffers (both ratioed and referenced) and one differential output driver. One of the 
referenced input buffers can also be configured as a differential input. In these banks the two pads in the pair 
are described as “true” and “comp”, where the true pad is associated with the positive side of the differential I/O, 
and the comp (complementary) pad is associated with the negative side of the differential I/O. 

In addition, programmable on-chip input termination (parallel or differential, static or dynamic) is supported on 
these sides, which is required for DDR3 interface. However, there is no support for hot-socketing for the I/O 
pins located on the left and right side of the device as the PCI clamp is always enabled on these pins.

LVDS, RSDS, PPLVDS and Mini-LVDS differential output drivers are available on 50% of the buffer pairs on the 
left and right banks. 

3. Configuration Bank sysI/O Buffer Pairs (Single-Ended Outputs, Only on Shared Pins When Not Used by 
Configuration)
The sysI/O buffers in the Configuration Bank consist of ratioed single-ended output drivers and single-ended 
input buffers. This bank does not support PCI clamp like the other banks on the top, left, and right sides. 

The two pads in the pair are described as “true” and “comp”, where the true pad is associated with the positive 
side of the differential input buffer and the comp (complementary) pad is associated with the negative side of 
the differential input buffer. 

Programmable PCI clamps are only available on the top banks. PCI clamps are used primarily on inputs and bi-
directional pads to reduce ringing on the receiving end.

Typical sysI/O I/O Behavior During Power-up 
The internal power-on-reset (POR) signal is deactivated when VCC, VCCIO8 and VCCAUX have reached satisfactory 
levels. After the POR signal is deactivated, the FPGA core logic becomes active. It is the user’s responsibility to 
ensure that all other VCCIO banks are active with valid input logic levels to properly control the output logic states of 
all the I/O banks that are critical to the application. For more information about controlling the output logic state with 
valid input logic levels during power-up in LatticeECP3 devices, see the list of technical documentation at the end 
of this data sheet. 

The VCC and VCCAUX supply the power to the FPGA core fabric, whereas the VCCIO supplies power to the I/O buf-
fers. In order to simplify system design while providing consistent and predictable I/O behavior, it is recommended 
that the I/O buffers be powered-up prior to the FPGA core fabric. VCCIO supplies should be powered-up before or 
together with the VCC and VCCAUX supplies. 

Supported sysI/O Standards 
The LatticeECP3 sysI/O buffer supports both single-ended and differential standards. Single-ended standards can 
be further subdivided into LVCMOS, LVTTL and other standards. The buffers support the LVTTL, LVCMOS 1.2 V, 
1.5 V, 1.8 V, 2.5 V and 3.3 V standards. In the LVCMOS and LVTTL modes, the buffer has individual configuration 
options for drive strength, slew rates, bus maintenance (weak pull-up, weak pull-down, or a bus-keeper latch) and 
open drain. Other single-ended standards supported include SSTL and HSTL. Differential standards supported 
include LVDS, BLVDS, LVPECL, MLVDS, RSDS, Mini-LVDS, PPLVDS (point-to-point LVDS), TRLVDS (Transition 
Reduced LVDS), differential SSTL and differential HSTL. For further information on utilizing the sysI/O buffer to 
support a variety of standards please see TN1177, LatticeECP3 sysIO Usage Guide. 

www.latticesemi.com/dynamic/view_document.cfm?document_id=32317
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There are some restrictions to be aware of when using spread spectrum. When a quad shares a PCI Express x1 
channel with a non-PCI Express channel, ensure that the reference clock for the quad is compatible with all proto-
cols within the quad. For example, a PCI Express spread spectrum reference clock is not compatible with most 
Gigabit Ethernet applications because of tight CTC ppm requirements.

While the LatticeECP3 architecture will allow the mixing of a PCI Express channel and a Gigabit Ethernet, Serial 
RapidIO or SGMII channel within the same quad, using a PCI Express spread spectrum clocking as the transmit 
reference clock will cause a violation of the Gigabit Ethernet, Serial RapidIO and SGMII transmit jitter specifica-
tions.

For further information on SERDES, please see TN1176, LatticeECP3 SERDES/PCS Usage Guide.

IEEE 1149.1-Compliant Boundary Scan Testability 
All LatticeECP3 devices have boundary scan cells that are accessed through an IEEE 1149.1 compliant Test 
Access Port (TAP). This allows functional testing of the circuit board on which the device is mounted through a 
serial scan path that can access all critical logic nodes. Internal registers are linked internally, allowing test data to 
be shifted in and loaded directly onto test nodes, or test data to be captured and shifted out for verification. The test 
access port consists of dedicated I/Os: TDI, TDO, TCK and TMS. The test access port has its own supply voltage 
VCCJ and can operate with LVCMOS3.3, 2.5, 1.8, 1.5 and 1.2 standards. 

For more information, please see TN1169, LatticeECP3 sysCONFIG Usage Guide.

Device Configuration 
All LatticeECP3 devices contain two ports that can be used for device configuration. The Test Access Port (TAP), 
which supports bit-wide configuration, and the sysCONFIG port, support dual-byte, byte and serial configuration. 
The TAP supports both the IEEE Standard 1149.1 Boundary Scan specification and the IEEE Standard 1532 In- 
System Configuration specification. The sysCONFIG port includes seven I/Os used as dedicated pins with the 
remaining pins used as dual-use pins. See TN1169, LatticeECP3 sysCONFIG Usage Guide for more information 
about using the dual-use pins as general purpose I/Os.

There are various ways to configure a LatticeECP3 device:

1. JTAG

2. Standard Serial Peripheral Interface (SPI and SPIm modes) - interface to boot PROM memory

3. System microprocessor to drive a x8 CPU port (PCM mode)

4. System microprocessor to drive a serial slave SPI port (SSPI mode)

5. Generic byte wide flash with a MachXO™ device, providing control and addressing

On power-up, the FPGA SRAM is ready to be configured using the selected sysCONFIG port. Once a configuration 
port is selected, it will remain active throughout that configuration cycle. The IEEE 1149.1 port can be activated any 
time after power-up by sending the appropriate command through the TAP port. 

LatticeECP3 devices also support the Slave SPI Interface. In this mode, the FPGA behaves like a SPI Flash device 
(slave mode) with the SPI port of the FPGA to perform read-write operations.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32316
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
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Table 2-16. Selectable Master Clock (MCCLK) Frequencies During Configuration (Nominal)

Density Shifting 
The LatticeECP3 family is designed to ensure that different density devices in the same family and in the same 
package have the same pinout. Furthermore, the architecture ensures a high success rate when performing design 
migration from lower density devices to higher density devices. In many cases, it is also possible to shift a lower uti-
lization design targeted for a high-density device to a lower density device. However, the exact details of the final 
resource utilization will impact the likelihood of success in each case. An example is that some user I/Os may 
become No Connects in smaller devices in the same package. Refer to the LatticeECP3 Pin Migration Tables and 
Diamond software for specific restrictions and limitations.

MCCLK (MHz) MCCLK (MHz) 

10

2.51 13

4.3 152

5.4 20

6.9 26

8.1 333

9.2

1. Software default MCCLK frequency. Hardware default is 3.1 MHz.
2. Maximum MCCLK with encryption enabled.
3. Maximum MCCLK without encryption.

http://www.latticesemi.com/dynamic/index.cfm?fuseaction=view_documents&document_type=32&sloc=01-01-00-10
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sysI/O Recommended Operating Conditions

Standard

VCCIO VREF (V)

Min. Typ. Max. Min. Typ. Max.

LVCMOS332 3.135 3.3 3.465 — — —

LVCMOS33D 3.135 3.3 3.465 — — —

LVCMOS252 2.375 2.5 2.625 — — —

LVCMOS18 1.71 1.8 1.89 — — —

LVCMOS15 1.425 1.5 1.575 — — —

LVCMOS122 1.14 1.2 1.26 — — —

LVTTL332 3.135 3.3 3.465 — — —

PCI33 3.135 3.3 3.465 — — —

SSTL153 1.43 1.5 1.57 0.68 0.75 0.9

SSTL18_I, II2 1.71 1.8 1.89 0.833 0.9 0.969

SSTL25_I, II2 2.375 2.5 2.625 1.15 1.25 1.35

SSTL33_I, II2 3.135 3.3 3.465 1.3 1.5 1.7

HSTL15_I2 1.425 1.5 1.575 0.68 0.75 0.9

HSTL18_I, II2 1.71 1.8 1.89 0.816 0.9 1.08

LVDS252 2.375 2.5 2.625 — — —

LVDS25E 2.375 2.5 2.625 — — —

MLVDS1 2.375 2.5 2.625 — — —

LVPECL331, 2 3.135 3.3 3.465 — — —

Mini LVDS 2.375 2.5 2.625 — — —

BLVDS251, 2 2.375 2.5 2.625 — — —

RSDS2 2.375 2.5 2.625 — — —

RSDSE1, 2 2.375 2.5 2.625 — — —

TRLVDS 3.14 3.3 3.47 — — —

PPLVDS 3.14/2.25 3.3/2.5 3.47/2.75 — — —

SSTL15D3 1.43 1.5 1.57 — — —

SSTL18D_I2, 3, II2, 3 1.71 1.8 1.89 — — —

SSTL25D_ I2, II2 2.375 2.5 2.625 — — —

SSTL33D_ I2, II2 3.135 3.3 3.465 — — —

HSTL15D_ I2 1.425 1.5 1.575 — — —

HSTL18D_ I2, II2 1.71 1.8 1.89 — — —

1. Inputs on chip. Outputs are implemented with the addition of external resistors.
2. For input voltage compatibility, see TN1177, LatticeECP3 sysIO Usage Guide. 
3. VREF is required when using Differential SSTL to interface to DDR memory.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32317
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Generic DDRX2 Output with Clock and Data (>10 Bits Wide) Centered at Pin  Using PLL (GDDRX2_TX.PLL.Centered)10

Left and Right Sides

tDVBGDDR Data Valid Before CLK All ECP3EA Devices 285 — 370 — 431 — ps

tDVAGDDR Data Valid After CLK All ECP3EA Devices 285 — 370 — 432 — ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 500 — 420 — 375 MHz

Memory Interface

DDR/DDR2 I/O Pin Parameters (Input Data are Strobe Edge Aligned, Output Strobe Edge is Data Centered)4 

tDVADQ Data Valid After DQS (DDR Read) All ECP3 Devices — 0.225 — 0.225 — 0.225 UI

tDVEDQ Data Hold After DQS (DDR Read) All ECP3 Devices 0.64 — 0.64 — 0.64 — UI

tDQVBS Data Valid Before DQS All ECP3 Devices 0.25 — 0.25 — 0.25 — UI

tDQVAS Data Valid After DQS  All ECP3 Devices 0.25 — 0.25 — 0.25 — UI

fMAX_DDR DDR Clock Frequency All ECP3 Devices 95 200 95 200 95 166 MHz

fMAX_DDR2 DDR2 clock frequency All ECP3 Devices 125 266 125 200 125 166 MHz

DDR3 (Using PLL for SCLK) I/O Pin Parameters

tDVADQ Data Valid After DQS (DDR Read) All ECP3 Devices — 0.225 — 0.225 — 0.225 UI

tDVEDQ Data Hold After DQS (DDR Read) All ECP3 Devices 0.64 — 0.64 — 0.64 — UI

tDQVBS Data Valid Before DQS All ECP3 Devices 0.25 — 0.25 — 0.25 — UI

tDQVAS Data Valid After DQS  All ECP3 Devices 0.25 — 0.25 — 0.25 — UI

fMAX_DDR3 DDR3 clock frequency All ECP3 Devices 300 400 266 333 266 300 MHz

DDR3 Clock Timing

tCH (avg)9 Average High Pulse Width All ECP3 Devices 0.47 0.53 0.47 0.53 0.47 0.53 UI

tCL (avg)9 Average Low Pulse Width All ECP3 Devices 0.47 0.53 0.47 0.53 0.47 0.53 UI

tJIT (per, lck)9 Output Clock Period Jitter During 
DLL Locking Period All ECP3 Devices –90 90 –90 90 –90 90 ps

tJIT (cc, lck)9 Output Cycle-to-Cycle Period Jit-
ter During DLL Locking Period All ECP3 Devices — 180 — 180 — 180 ps

1. Commercial timing numbers are shown. Industrial numbers are typically slower and can be extracted from the Diamond or ispLEVER soft-
ware.

2. General I/O timing numbers based on LVCMOS 2.5, 12mA, Fast Slew Rate, 0pf load.
3. Generic DDR timing numbers based on LVDS I/O.
4. DDR timing numbers based on SSTL25. DDR2 timing numbers based on SSTL18.
5. DDR3 timing numbers based on SSTL15.
6. Uses LVDS I/O standard.
7. The current version of software does not support per bank skew numbers; this will be supported in a future release.
8. Maximum clock frequencies are tested under best case conditions. System performance may vary upon the user environment.
9. Using settings generated by IPexpress.
10. These numbers are generated using best case PLL located in the center of the device.
11. Uses SSTL25 Class II Differential I/O Standard.
12. All numbers are generated with ispLEVER 8.1 software.
13. For details on -9 speed grade devices, please contact your Lattice Sales Representative.

LatticeECP3 External Switching Characteristics (Continued)1, 2, 3, 13

Over Recommended Commercial Operating Conditions

Parameter Description Device

–8 –7 –6

UnitsMin. Max. Min. Max. Min. Max.
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LatticeECP3 Family Timing Adders1, 2, 3, 4, 5, 7 
Over Recommended Commercial Operating Conditions

Buffer Type Description –8 –7 –6 Units

Input Adjusters 

LVDS25E LVDS, Emulated, VCCIO = 2.5 V 0.03 –0.01 –0.03 ns

LVDS25 LVDS, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

BLVDS25 BLVDS, Emulated, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

MLVDS25 MLVDS, Emulated, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

RSDS25 RSDS, VCCIO = 2.5 V 0.03 –0.01 –0.03 ns

PPLVDS Point-to-Point LVDS 0.03 –0.01 –0.03 ns

TRLVDS Transition-Reduced LVDS 0.03 0.00 –0.04 ns

Mini MLVDS Mini LVDS 0.03 –0.01 –0.03 ns

LVPECL33 LVPECL, Emulated, VCCIO = 3.3 V 0.17 0.23 0.28 ns

HSTL18_I HSTL_18 class I, VCCIO = 1.8 V 0.20 0.17 0.13 ns

HSTL18_II HSTL_18 class II, VCCIO = 1.8 V 0.20 0.17 0.13 ns

HSTL18D_I Differential HSTL 18 class I 0.20 0.17 0.13 ns

HSTL18D_II Differential HSTL 18 class II 0.20 0.17 0.13 ns

HSTL15_I HSTL_15 class I, VCCIO = 1.5 V 0.10 0.12 0.13 ns

HSTL15D_I Differential HSTL 15 class I 0.10 0.12 0.13 ns

SSTL33_I SSTL_3 class I, VCCIO = 3.3 V 0.17 0.23 0.28 ns

SSTL33_II SSTL_3 class II, VCCIO = 3.3 V 0.17 0.23 0.28 ns

SSTL33D_I Differential SSTL_3 class I 0.17 0.23 0.28 ns

SSTL33D_II Differential SSTL_3 class II 0.17 0.23 0.28 ns

SSTL25_I SSTL_2 class I, VCCIO = 2.5 V 0.12 0.14 0.16 ns

SSTL25_II SSTL_2 class II, VCCIO = 2.5 V 0.12 0.14 0.16 ns

SSTL25D_I Differential SSTL_2 class I 0.12 0.14 0.16 ns

SSTL25D_II Differential SSTL_2 class II 0.12 0.14 0.16 ns

SSTL18_I SSTL_18 class I, VCCIO = 1.8 V 0.08 0.06 0.04 ns

SSTL18_II SSTL_18 class II, VCCIO = 1.8 V 0.08 0.06 0.04 ns

SSTL18D_I Differential SSTL_18 class I 0.08 0.06 0.04 ns

SSTL18D_II Differential SSTL_18 class II 0.08 0.06 0.04 ns

SSTL15 SSTL_15, VCCIO = 1.5 V 0.087 0.059 0.032 ns

SSTL15D Differential SSTL_15 0.087 0.059 0.032 ns

LVTTL33 LVTTL, VCCIO = 3.3 V 0.07 0.07 0.07 ns

LVCMOS33 LVCMOS, VCCIO = 3.3 V 0.07 0.07 0.07 ns

LVCMOS25 LVCMOS, VCCIO = 2.5 V 0.00 0.00 0.00 ns

LVCMOS18 LVCMOS, VCCIO = 1.8 V –0.13 –0.13 –0.13 ns

LVCMOS15 LVCMOS, VCCIO = 1.5 V –0.07 –0.07 –0.07 ns

LVCMOS12 LVCMOS, VCCIO = 1.2 V –0.20 –0.19 –0.19 ns

PCI33 PCI, VCCIO = 3.3 V 0.07 0.07 0.07 ns

Output Adjusters 

LVDS25E LVDS, Emulated, VCCIO = 2.5 V 1.02 1.14 1.26 ns

LVDS25 LVDS, VCCIO = 2.5 V –0.11 –0.07 –0.03 ns

BLVDS25 BLVDS, Emulated, VCCIO = 2.5 V 1.01 1.13 1.25 ns

MLVDS25 MLVDS, Emulated, VCCIO = 2.5 V 1.01 1.13 1.25 ns
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LatticeECP3 Maximum I/O Buffer Speed 1, 2, 3, 4, 5, 6

Over Recommended Operating Conditions

Buffer Description Max. Units

Maximum Input Frequency

LVDS25 LVDS, VCCIO = 2.5 V 400 MHz

MLVDS25 MLVDS, Emulated, VCCIO = 2.5 V 400 MHz

BLVDS25 BLVDS, Emulated, VCCIO = 2.5 V 400 MHz

PPLVDS Point-to-Point LVDS 400 MHz

TRLVDS Transition-Reduced LVDS 612 MHz

Mini LVDS Mini LVDS 400 MHz

LVPECL33 LVPECL, Emulated, VCCIO = 3.3 V 400 MHz

HSTL18 (all supported classes) HSTL_18 class I, II, VCCIO = 1.8 V 400 MHz

HSTL15 HSTL_15 class I, VCCIO = 1.5 V 400 MHz

SSTL33 (all supported classes) SSTL_3 class I, II, VCCIO = 3.3 V 400 MHz

SSTL25 (all supported classes) SSTL_2 class I, II, VCCIO = 2.5 V 400 MHz

SSTL18 (all supported classes) SSTL_18 class I, II, VCCIO = 1.8 V 400 MHz

LVTTL33 LVTTL, VCCIO = 3.3 V 166 MHz

LVCMOS33 LVCMOS, VCCIO = 3.3 V 166 MHz

LVCMOS25 LVCMOS, VCCIO = 2.5 V 166 MHz

LVCMOS18 LVCMOS, VCCIO = 1.8 V 166 MHz

LVCMOS15 LVCMOS 1.5, VCCIO = 1.5 V 166 MHz

LVCMOS12 LVCMOS 1.2, VCCIO = 1.2 V 166 MHz

PCI33 PCI, VCCIO = 3.3 V 66 MHz

Maximum Output Frequency

LVDS25E LVDS, Emulated, VCCIO = 2.5 V 300 MHz

LVDS25 LVDS, VCCIO = 2.5 V 612 MHz

MLVDS25 MLVDS, Emulated, VCCIO = 2.5 V 300 MHz

RSDS25 RSDS, Emulated, VCCIO = 2.5 V 612 MHz

BLVDS25 BLVDS, Emulated, VCCIO = 2.5 V 300 MHz

PPLVDS Point-to-point LVDS 612 MHz

LVPECL33 LVPECL, Emulated, VCCIO = 3.3 V 612 MHz

Mini-LVDS Mini LVDS 612 MHz

HSTL18 (all supported classes) HSTL_18 class I, II, VCCIO = 1.8 V 200 MHz

HSTL15 (all supported classes) HSTL_15 class I, VCCIO = 1.5 V 200 MHz

SSTL33 (all supported classes) SSTL_3 class I, II, VCCIO = 3.3 V 233 MHz

SSTL25 (all supported classes) SSTL_2 class I, II, VCCIO = 2.5 V 233 MHz

SSTL18 (all supported classes) SSTL_18 class I, II, VCCIO = 1.8 V 266 MHz

LVTTL33 LVTTL, VCCIO = 3.3 V 166 MHz

LVCMOS33 (For all drives) LVCMOS, 3.3 V 166 MHz

LVCMOS25 (For all drives) LVCMOS, 2.5 V 166 MHz

LVCMOS18 (For all drives) LVCMOS, 1.8 V 166 MHz

LVCMOS15 (For all drives) LVCMOS, 1.5 V 166 MHz

LVCMOS12 (For all drives except 2 mA) LVCMOS, VCCIO = 1.2 V 166 MHz

LVCMOS12 (2 mA drive) LVCMOS, VCCIO = 1.2 V 100 MHz
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Figure 3-16. Jitter Transfer – 1.25 Gbps

Figure 3-17. Jitter Transfer – 622 Mbps
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Serial Rapid I/O Type 2/CPRI LV E.24 Electrical and Timing Characteristics
AC and DC Characteristics
Table 3-15. Transmit

Table 3-16. Receive and Jitter Tolerance

Symbol Description Test Conditions Min. Typ. Max. Units

TRF
1 Differential rise/fall time 20%-80% — 80 — ps

ZTX_DIFF_DC Differential impedance 80 100 120 Ohms

JTX_DDJ
3, 4, 5 Output data deterministic jitter — — 0.17 UI

JTX_TJ
2, 3, 4, 5 Total output data jitter — — 0.35 UI

1. Rise and Fall times measured with board trace, connector and approximately 2.5pf load.
2. Total jitter includes both deterministic jitter and random jitter. The random jitter is the total jitter minus the actual deterministic jitter.
3. Jitter values are measured with each CML output AC coupled into a 50-Ohm impedance (100-Ohm differential impedance).
4. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
5. Values are measured at 2.5 Gbps.

Symbol Description Test Conditions Min. Typ. Max. Units

RLRX_DIFF Differential return loss From 100 MHz to 2.5 GHz 10 — — dB

RLRX_CM Common mode return loss From 100 MHz to 2.5 GHz 6 — — dB

ZRX_DIFF Differential termination resistance 80 100 120 Ohms

JRX_DJ
2, 3, 4, 5 Deterministic jitter tolerance (peak-to-peak) — — 0.37 UI

JRX_RJ
2, 3, 4, 5 Random jitter tolerance (peak-to-peak) — — 0.18 UI

JRX_SJ
2, 3, 4, 5 Sinusoidal jitter tolerance (peak-to-peak) — — 0.10 UI

JRX_TJ
1, 2, 3, 4, 5 Total jitter tolerance (peak-to-peak) — — 0.65 UI

TRX_EYE Receiver eye opening 0.35 — — UI

1. Total jitter includes deterministic jitter, random jitter and sinusoidal jitter. The sinusoidal jitter tolerance mask is shown in Figure 3-18.
2. Jitter values are measured with each high-speed input AC coupled into a 50-Ohm impedance.
3. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
4. Jitter tolerance, Differential Input Sensitivity and Receiver Eye Opening parameters are characterized when Full Rx Equalization is enabled.
5. Values are measured at 2.5 Gbps.



3-60

DC and Switching Characteristics
LatticeECP3 Family Data Sheet

Switching Test Conditions
Figure 3-33 shows the output test load that is used for AC testing. The specific values for resistance, capacitance, 
voltage, and other test conditions are shown in Table 3-23. 

Figure 3-33. Output Test Load, LVTTL and LVCMOS Standards

Table 3-23. Test Fixture Required Components, Non-Terminated Interfaces

Test Condition R1 R2 CL Timing Ref. VT

LVTTL and other LVCMOS settings (L -> H, H -> L)   0 pF

LVCMOS 3.3 = 1.5V —

LVCMOS 2.5 = VCCIO/2 —

LVCMOS 1.8 = VCCIO/2 —

LVCMOS 1.5 = VCCIO/2 —

LVCMOS 1.2 = VCCIO/2 —

LVCMOS 2.5 I/O (Z -> H)  1M 0 pF VCCIO/2 —

LVCMOS 2.5 I/O (Z -> L) 1 M  0 pF VCCIO/2 VCCIO

LVCMOS 2.5 I/O (H -> Z)  100 0 pF VOH - 0.10 —

LVCMOS 2.5 I/O (L -> Z) 100  0 pF VOL + 0.10 VCCIO

Note: Output test conditions for all other interfaces are determined by the respective standards.

DUT 

VT

R1

R2

 

CL* 

Test Point

*CL Includes Test Fixture and Probe Capacitance
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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LatticeECP3 Part Number Description

LFE3 – XXX XX – X X XXXXXX  X

Grade
    C = Commercial
    I = Industrial    Logic Capacity

     17 = 17K LUTs
     35 = 33K LUTs
     70 = 67K LUTs
     95 = 92K LUTs
    150 = 149K LUTs
     Supply Voltage
     EA = 1.2 V

Speed
     6 = Slowest
     7
     8 = Fastest for LatticeECP3-17EA

1. Green = Halogen free and lead free.

Power
     Blank = Standard Power
     L = Low Power 

Package
    FTN256 = 256-ball Lead-Free ftBGA
    FN484 = 484-ball Lead-Free fpBGA
    FN672 = 672-ball Lead-Free fpBGA
    FN1156 = 1156-ball Lead-Free fpBGA
    MG328 = 328-ball Green csBGA1

Device Family
    ECP3 (LatticeECP3 FPGA + SERDES)
 

Ordering Information
LatticeECP3 devices have top-side markings, for commercial and industrial grades, as shown below:

Note: See PCN 05A-12 for information regarding a change to the top-side mark logo.

LFE3-95EA
7FN672C
Datecode

LFE3-95EA
7FN672I
Datecode

Commercial Industrial

LatticeECP3 Family Data Sheet
Ordering Information

http://www.latticesemi.com/documents/doc44912x28.pdf
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For Further Information
A variety of technical notes for the LatticeECP3 family are available on the Lattice website at www.latticesemi.com.

• TN1169, LatticeECP3 sysCONFIG Usage Guide

• TN1176, LatticeECP3 SERDES/PCS Usage Guide

• TN1177, LatticeECP3 sysIO Usage Guide

• TN1178, LatticeECP3 sysCLOCK PLL/DLL Design and Usage Guide

• TN1179, LatticeECP3 Memory Usage Guide

• TN1180, LatticeECP3 High-Speed I/O Interface

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• TN1182, LatticeECP3 sysDSP Usage Guide

• TN1184, LatticeECP3 Soft Error Detection (SED) Usage Guide

• TN1189, LatticeECP3 Hardware Checklist 

• TN1215, LatticeECP2MS and LatticeECP2S Devices 

• TN1216, LatticeECP2/M and LatticeECP3 Dual Boot Feature Advanced Security Encryption Key Program-
ming Guide for LatticeECP3

• TN1222, LatticeECP3 Slave SPI Port User's Guide

For further information on interface standards refer to the following websites:

• JEDEC Standards (LVTTL, LVCMOS, SSTL, HSTL): www.jedec.org
• PCI: www.pcisig.com

LatticeECP3 Family Data Sheet
Supplemental Information

www.latticesemi.com/~/media/Documents/ApplicationNotes/AD/AdvancedSecurityEncryptionKeyProgrammingGuideforLatticeECP3LatticeECP2MSandLatticeECP2SDevices.PDF
www.latticesemi.com/~/media/Documents/ApplicationNotes/L/AM/LatticeECP2MandLatticeECP3DualBootFeature.PDF
www.latticesemi.com/~/media/Documents/ApplicationNotes/L/AM/LatticeECP2MandLatticeECP3DualBootFeature.PDF
www.latticesemi.com/dynamic/view_document.cfm?document_id=32318
www.latticesemi.com/dynamic/view_document.cfm?document_id=32319
www.latticesemi.com/dynamic/view_document.cfm?document_id=32320
www.latticesemi.com/dynamic/view_document.cfm?document_id=32317
www.latticesemi.com/dynamic/view_document.cfm?document_id=32322
www.latticesemi.com/dynamic/view_document.cfm?document_id=32323
www.latticesemi.com/dynamic/view_document.cfm?document_id=32324
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
www.latticesemi.com/~/media/Documents/ApplicationNotes/L/AM/LatticeECP3SlaveSPIPortUsersGuide.pdf
www.pcisig.com
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
www.latticesemi.com/dynamic/view_document.cfm?document_id=32316
www.jedec.org
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LatticeECP3 Maximum I/O Buffer Speed table – Description column, 
references to VCCIO = 3.0V changed to 3.3V.

Updated SERDES External Reference Clock Waveforms.

Transmitter and Receiver Latency Block Diagram – Updated sections of 
the diagram to match descriptions on the SERDES/PCS Latency Break-
down table. 

Pinout Information “Logic Signal Connections” section heading renamed “Package Pinout 
Information”. Software menu selections within this section have been 
updated.

Signal Descriptions table – Updated description for VCCA signal.

April 2012 02.2EA Architecture Updated first paragraph of Output Register Block section.

Updated the information about sysIO buffer pairs below Figure 2-38.

Updated the information relating to migration between devices in the 
Density Shifting section.

DC and Switching
Characteristics

Corrected the Definitions in the sysCLOCK PLL Timing table for tRST.

Ordering Information Updated topside marks with new logos in the Ordering Information sec-
tion.

February 2012 02.1EA All Updated document with new corporate logo.

November 2011 02.0EA Introduction Added information for LatticeECP3-17EA, 328-ball csBGA package.

Architecture Added information for LatticeECP3-17EA, 328-ball csBGA package.

DC and Switching 
Characteristics

Updated LatticeECP3 Supply Current table power numbers.

Typical Building Block Function Performance table, LatticeECP3 Exter-
nal Switching Characteristics table, LatticeECP3 Internal Switching 
Characteristics table and LatticeECP3 Family Timing Adders: Added 
speed grade -9 and updated speed grade -8, -7 and -6 timing numbers. 

Pinout Information Added information for LatticeECP3-17EA, 328-ball csBGA package.

Ordering Information Added information for LatticeECP3-17EA, 328-ball csBGA package.

Added ordering information for low power devices and -9 speed grade 
devices.

July 2011 01.9EA DC and Switching 
Characteristics

Removed ESD Performance table and added reference to LatticeECP3 
Product Family Qualification Summary document.

sysCLOCK PLL TIming table, added footnote 4.

External Reference Clock Specification table – removed reference to 
VREF-CM-AC and removed footnote for VREF-CM-AC.

Pinout Information Pin Information Summary table: Corrected VCCIO Bank8 data for
LatticeECP3-17EA 256-ball ftBGA package and LatticeECP-35EA 256-
ball ftBGA package.

April 2011 01.8EA Architecture Updated Secondary Clock/Control Sources text section.

DC and Switching 
Characteristics

Added data for 150 Mbps to SERDES Power Supply Requirements 
table.

Updated Frequencies in Table 3-6 Serial Output Timing and Levels

Added Data for 150 Mbps to Table 3-7 Channel Output Jitter

Corrected External Switching Characteristics table, Description for 
DDR3 Clock Timing, tJIT.

Corrected Internal Switching Characteristics table, Description for EBR 
Timing, tSUWREN_EBR and tHWREN_EBR.

Added footnote 1 to sysConfig Port Timing Specifications table.

Updated description for RX-CIDs to 150M in Table 3-9 Serial Input Data 
Specifications

Date Version Section Change Summary
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Updated Frequency to 150 Mbps in Table 3-11 Periodic Receiver Jitter 
Tolerance Specification

December 2010 01.7EA Multiple Data sheet made final. Removed “preliminary” headings.

Removed data for 70E and 95E devices. A separate data sheet is avail-
able for these specific devices.

Updated for Lattice Diamond design software.

Introduction Corrected number of user I/Os

Architecture Corrected the package type in Table 2-14 Available SERDES Quad per 
LatticeECP3 Devices. 

Updated description of General Purpose PLL

Added additional information in the Flexible Quad SERDES Architecture 
section.

Added footnotes and corrected the information in Table 2-16 Selectable 
master Clock (MCCLK) Frequencies During Configuration (Nominal).

Updated Figure 2-16, Per Region Secondary Clock Selection.

Updated description for On-Chip Programmable Termination.

Added information about number of rows of DSP slices.

Updated footnote 2 for Table 2-12, On-Chip Termination Options for 
Input Modes.

Updated information for sysIO buffer pairs.

Corrected minimum number of General Purpose PLLs (was 4, now 2).

DC and Switching 
Characteristics

Regenerated sysCONFIG Port Timing figure.

Added tW (clock pulse width) in External Switching Characteristics 
table.

Corrected units, revised and added data, and corrected footnote 1 in 
External Switching Characteristics table.

Added Jitter Transfer figures in SERDES External Reference Clock sec-
tion.

Corrected capacitance information in the DC Electrical Characteristics 
table.

Corrected data in the Register-to-Register Performance table.

Corrected GDDR Parameter name HOGDDR.

Corrected RSDS25 -7 data in Family Timing Adders table.

Added footnotes 10-12 to DDR data information in the External Switch-
ing Characteristics table.

Corrected titles for Figures 3-7 (DDR/DDR2/DDR3 Parameters) and 
3-8 (Generic DDR/DDRX2 Parameters).

Updated titles for Figures 3-5 (MLVDS25 (Multipoint Low Voltage Differ-
ential Signaling)) and 3-6 (Generic DDRX1/DDRX2 (With Clock and 
Data Edges Aligned)).

Updated Supply Current table.

Added GDDR interface information to the External Switching and Char-
acteristics table.

Added footnote to sysIO Recommended Operating Conditions table.

Added footnote to LVDS25 table.

Corrected DDR section footnotes and references.

Corrected Hot Socketing support from “top and bottom banks” to “top 
and bottom I/O pins”.

Pinout Information Updated description for VTTx.

Date Version Section Change Summary


